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Abstract

With the advent of the Internet as a medium of sharing resources like text, images, 

audio, video, documents etc., the Web users made it a way to interchange the 

knowledge as well. This behavior of the Web users over the Internet phenomenally 

turned the WWW into a huge repository of unstructured data inducing a need of the 

standard based representation of the data over the Internet. This need made itself 

more demanding because the searching or extraction of the knowledge from the 

unorganized data was becoming impossible, giving rise to the concept of Semantic 

Web. The use of XML for representing the data made the situation at the rest in the 

meanwhile. But, only the syntactical exploitation of the data could not help the 

situation because the process like searching of the images on the Web demanded the 

inclusion of the supplement of semantic structures into the list of standards. The 

Resource Description Framework (RDF) standard, a base technology of the Semantic 

Web, appeared as an intuitive solution of this problem as it employs the concept of 

annotation to describe the images and keeps all pieces of information pertaining to 

the images in the RDF documents, making the search process semantic rather than 

the traditional.

In this thesis, the intent is to generate annotated RDF model for semantic retrieval of 

images using RDF editor for annotation. This RDF model is validated through online 

W3C RDF validation service. SPARQL, RDF query engine, is used to query the 

validated RDF model to check the efficiency of image search.
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Chapter 1

Introduction

The Internet revolutionised the way in which our society disseminates and uses 

information. The popularity of the Internet resulted in an exponential growth of 

information available on the Internet and the associated Web. A consequence of this 

popularity is an overload of information available on almost any topic which in turn 

has created several new problems for users. How to find required information in such 

a short time has become the key constraint to the process of human society progress 

while facing the vast ocean of information. For example, it is increasingly difficult to 

find applicable information or to verify the origin of information. In addition, it is 

difficult to verify that the information, or even the source of the information, is 

trustworthy.

With the growth of multimedia the huge amount of images are increasing daily on the 

internet. In simple search user gets many irrelevant images and to retrieve the accurate 

images from the Web according to user query is a challenging task. To find the proper

result from the Web need is to enrich the annotation process as much as possible and

move toward the semantic image search.

1.1 Image Search in Search Engine

Although Internet has contributed a lot for human society, the explosive growth of 

multimedia data transmission has generated a critical need for efficient, high-capacity 

image databases, as well as powerful search engines to retrieve image desired from 

them. At present, main search engines have developed a series of feasible solutions 

for text search as text is a kind of structural information, which also have already been 

taken into commercial use phrase. Google PageRank or Baidu’s own ranking 

algorithm [1], has reached satisfactory result on text information search area, helping 

users find useful information in relatively short time, but with the pluralism of internet 

media, unique text search service cannot meet customers’ current requirement. As one 

of the most important media for presentation, images have become significant as text 

information recently, but the performance of images search engine is still less than 

satisfactory.
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An image search is a systematic process that includes browsing, searching and 

retrieving images from a large database of digital images. Various image search 

options available today on World Wide Web are:

Google Image Search - Google Image Search is the most frequently used image 

search engine in the world. It produces thousands of image results in response to users 

query – which are syntactically related to the words given by the user but may or may 

not be semantically related to the user’s request and thus it requires some serious 

filtering to get desired results. Major limitation of this engine is that at every click full 

page source is retrieved and user needs to click each individual thumbnail to open 

every image.

Yahoo! Image Search - Yahoo Image Search (http://images.search.yahoo.com) finds 

images that appear as a framed interface on a source page and it has a wide range of 

options which can be applied to searches. 

Flickr - Flickr Images is presently very popularly used and subscribed image sharing 

data base on the Web. Powered through Yahoo, it acts as a community space for 

storing photos and images. Copyrighted photos can be found in unique range, but it is 

rather rare. It has search options such as ‘most relevant’ and ‘most recent’ which 

makes searching easier.

In all these search engines, traditional and common methods of adding metadata such 

as captioning, keywords, or descriptions are used for image retrieval. 

1.1.1 Problems encountered in searching images on WWW

Search engines are based on simple keyword matching process so many a times they 

return the unexpected results for searched images.

For example, if user gives query for keyword ‘eclipse’ in Google Image Search it 

will return the following images:

                                    

       (a)  Eclipse-5exposures                                              (b)     Solar Eclipse        
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        (c) Mitsubishi Eclipse                                    (d) Integrated with Eclipse SDK          

Figure 1.1: Image return by Google Image Search for eclipse keyword

But these results of the keyword ‘eclipse’ may not comply with the need of the users 

because if the user is interested in word ‘eclipse’ related to astronomy, search for the 

word ‘eclipse’ gives images for eclipse car, eclipse software, etc.  

To present more precise result to each user with different occupations, hobbies, and 

some other background profiles; there is a need to modify search method and involve 

some factors of user’s background information. To solve this problem, images should 

be annotated so that image retrieval is semantic in nature. In addition to the classic 

“Web of documents”, W3C is building a technology stack to support a “Web of data,” 

the sort of data found in databases. The ultimate goal is to enable computers to do 

more useful work and to develop systems that can support trusted interactions over 

the network.

1.2 Semantic Web

1.2.1 Definition of Semantic Web

According to Tim Berners-Lee “The Semantic Web is an extension of the current 

Web in which information is given well-defined meaning, better enabling computers 

and people to work in cooperation” [2, 27].

"The Semantic Web is a vision: the idea of having data on the Web defined and linked 

in such a way that it can be used by machines not just for display purposes, but for 

automation, integration and reuse of data across various applications" [3].

Semantic means adding meaning of data to be discovered by computers. It is  a  vision  

of  a  new  architecture  for  the  World  Wide  Web, characterized  by  the  

association  of machine-accessible  formal  semantics with more traditional Web 
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content. The core idea is to create the meta data describing the data, which will enable 

computers to process the meaning of things.

The  ultimate  goal  of  the  Semantic Web [25, 26]  is  to  transform  the Web  into a 

medium  through which data can be shared, understood and processed by automated  

tools.  Semantic Web  techniques,  which  consist  of  applying  knowledge 

representation  techniques  in  a  distributed  environment  (potentially  on  a Web-

wide scale) have proven useful in providing richer descriptions of Web resources [4].

The Semantic Web extends the Web through the use of standards, markup languages 

and related processing tools. Semantic Web technologies enable people to create data 

stores on the Web, build vocabularies, and write rules for handling data. Linked data 

are empowered by technologies such as RDF, SPARQL, and OWL.

The vision of the Semantic Web is an extension of the existing Web through which 

machines are able to interoperate and work on our behalf. It promises to infuse the 

Internet with a combination of metadata, structure, and various technologies so that 

machines can derive meaning from information, make more intelligent choices, and 

complete tasks with reduced human intervention. Semantic web vision is oriented

toward machine-readable resources rather than human-readable. It requires resource 

description so that machines know what they mean (metadata) [5]. 

1.2.2 Structure of Semantic Web

Currently, the World Wide Web consists of documents written in HTML. This makes

the Web  readable  for  humans,  but  since  HTML  has  limited  ability  to  classify 

the blocks of text apart from the roles they play, the Web in  its current form  is very 

hard to  understand.  The  purpose  of  the  Semantic Web  is  to  add  a  layer  of  

descriptive technologies to Web pages so that become readable [6]. 

Figure 1.2: Berners-Lee’s Original Semantic Web Architecture [4]
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The Semantic Web is implemented in the layers of Web technologies and standards. 

The layers are presented in Figure 1.2 and described as follows:

 The  Unicode  and  Uniform  Resource  Identifier  (URI)  layers  make  sure  

that international characters sets are used and provide means for identifying  the 

objects  in the Semantic Web. The most popular URI’s on the World Wide Web 

are Uniform Resource Locaters (URLs).

 The XML layer with namespace and schema definitions make sure the Semantic 

Web definitions can integrate with the other XML based standards. XML 

provides a surface syntax for structured documents, but imposes no semantic 

constraints on the meaning of these documents. XML Schema is a language for 

restricting the structure of XML documents [7].

    XML Schemas provide greater flexibility in the definition of an XML 

application, even allowing the definition of complex data types. Furthermore, 

XML Schemas use the same syntactic style as other XML documents. However, 

XML Schema only gives XML an advanced grammar specification and data 

typing capability, and still suffers from the same semantic drawbacks as DTDs 

    The lack of semantics in XML DTDs and XML Schemas makes it difficult to 

integrate XML documents. 

 The Resource Description Framework (RDF) [28] is a W3C recommendation 

that attempts to address XML’s semantic limitations. It presents a simple model 

that can be used to represent any kind of data. This data model consists of nodes 

connected by labeled arcs, where the nodes represent Web resources and the 

arcs represent properties of these resources.

    RDF  Schema  is  a  simple  type  modeling  language    for  describing  classes  

of resources and properties between them in the basic RDF model.  It provides a 

simple reasoning framework for inferring types of resources.

 The ontology layer supports the evolution of vocabularies as it can define 

relations between the different concepts.  In this layer knowledge is expressed 

as descriptive statements, stating some relationship exists between one thing and 

another.

 A digital  signature  is  an  electronic  signature  that  can  be  used  to  

authenticate  the identity of the sender of a message or the signer of a document. 
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The Digital Signature layer ensures that the original content of the message or 

document is unaltered.

 The top layers Logic, Proof and Trust, are currently being researched and 

simple application demonstrations are being constructed. The Logic layer 

enables the writing of rules while the Proof layer executes the rules and 

evaluates together with the Trust layer mechanism for applications whether to 

trust the given proof or not.

The Semantic Web comprises the standards and tools of XML, XML Schema, RDF, 

RDF Schema and OWL. 

1.3 Resource Description Framework (RDF)

The Resource Description Framework (RDF) is a W3C standard for describing Web 

resources, such as the title, author, modification date, content, and copyright 

information of a Web page [8].

 RDF is designed to be read and understood by computers and it is not 

designed for being displayed to people.

 It is written in XML and it is a part of the W3C's Semantic Web Activity.

Resource Description Framework Define metadata vocabularies and use them to make

statements. Resource can be anything identifiable with a URI, Description is a

statement about properties of resources and Framework means a common model for 

statements using diverse vocabularies.

RDF  is a model and XML  syntax  for  representing  information  in a way  that 

allows programs  to  understand  the  intended  meaning .  It's  built  on  the  concept  

of  a statement,  a  triple  of  the  form  {predicate,  subject,  object}.  The 

interpretation of a triple is that <subject> has a property <predicate> whose value is 

<object>. In RDF a <subject>  is  always  a  resource  named  by  a  URI  with  an  

optional  anchor  id, <predicate> is a property of the resource, and the <object> is the 

value of the property for the resource [9]. Consider the following triples (figure 1.3):

{dc:Publisher, http://www.w3.org, "World Wide Web Consortium"}

{dc:Title,     http://www.w3.org, "W3C Home Page"}
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Figure 1.3: RDF triples

RDF syntax:

<rdf:RDF

xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"

xmlns:cd="http://www.recshop.fake/cd#">

<rdf:Description

rdf:about="http://www.recshop.fake/cd/Empire Burlesque">

<cd:artist>Bob Dylan</cd:artist>

  <cd:country>USA</cd:country>

<cd:company>Columbia</cd:company>

<cd:price>10.90</cd:price>

<cd:year>1985</cd:year>

</rdf:Description>

</rdf:RDF>

The first line of the RDF document is an XML declaration. The XML declaration is 

followed by the root element of RDF documents: <rdf:RDF>. The xmlns:rdf 

namespace specifies that elements with the rdf prefix are from the namespace 

"http://www.w3.org/1999/02/22-rdf-syntax-ns#". The xmlns:cd namespace specifies 

that elements with cd prefix are from the namespace “http://www.recshop.fake/cd#".

The <rdf:Description> element contains the description of the resource identified by 

the rdf:about attribute. The elements: <cd:artist>, <cd:country>, <cd:company>, etc. 

are properties of the resource. RDF has the following features [10]:
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 Reification: An important feature of RDF is its representation of a collection of 

resources.  In addition to making assertions about resources, RDF can be used to 

make assertions about other RDF statements. This means that an RDF statement 

can be used in place of an object or property value in an RDF triple, which is 

known as reification.  

 Collection of Resources: For  representing a  list of  resources, RDF uses  the 

type  “Container”  and  reified  statements  are  represented  using  the  type 

“Statement”. A Container object is used to represent a collection of resources in 

RDF.

The  three  different  types  of  container  objects defined  by  the RDF  specification  

are Bag,  Sequence  and Alternative. A Bag represents an unordered list of resources 

or literals; a Sequence represents an ordered list of resources or literals. Unlike the 

Bag container type, the order of resources or literals is important. Both Bag and 

Sequence are not sets, i.e., duplicate values are permitted in both container types.

1.4 Role of Annotations in Semantic Web

Meaningful use of any data requires knowledge about its organization and content. 

Contextual information that establishes relationships between the data and the real 

world aspects it applies to is called metadata. In other words, metadata is data that 

describes information about a piece of data, thereby creating a context in terms of the 

content and functionality of that data. Domain conceptualizations, ontologies or world 

models provide agreed upon and unambiguous models for capturing data and 

metadata to which applications, data providers and consumers can refer. Broadly 

speaking, there are two kinds of metadata - structural and syntactic metadata [11].  

Structural metadata provides information about the organization and structure of some 

data, e.g. format of the document. Semantic metadata on the other hand, provides

information 'about' the data for example the meaning or what the data is about and the 

available semantic relationships from a domain model in which the data is defined. 

The key aspect behind the realization of the Semantic Web vision is the provision of 

metadata and the association of metadata with web resources. 

The process of associating metadata with resources (audio, video, structured text, 

unstructured text, web pages, images etc) is called annotation and semantic 
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annotation is the process of annotating resources with semantic metadata. Semantic 

annotations can be coarsely classified as being formal or informal. Formal semantic 

annotations, unlike informal semantic annotations follow representation mechanisms, 

drawing on conceptual models represented using well-defined knowledge

representation languages. Such machine processable formal annotations on web 

resources can result in vastly improved and automated search capabilities, 

unambiguous resource discoveries, information analytics etc. The annotation of Web 

based resources like text files or digital content is very different from the annotation 

of Web services [11]. 

Annotation is about attaching names, attributes, comments, descriptions, etc. to a 

document or to a selected part in a text. It provides additional information (metadata) 

about an existing piece of data. Tagging is a sequence of characters used to provide 

some basic information to a document or images.

Compared to tagging, annotation speeds up searching and helps you find relevant and 

precise information; Semantic Annotation goes one level deeper:

 It enriches the unstructured or semi-structured data with a context that is 

further linked to the structured knowledge of a domain.

 It allows results that are not explicitly related to the original search.

So, if tagging is about promptly finding the most relevant result, semantic annotation 

adds diversity and richness to the process [12].

Thus an annotation is a form of meta-data attached to a particular section of document 

content. The section may be a single word, a sentence or even a series of paragraphs. 

An annotation must have a type (or a name) which is used to create classes of similar 

annotations, usually linked together by their semantics. 

Semantic Annotation helps to bridge the ambiguity of the natural language when 

expressing notions and their computational representation in a formal language. By 

telling a computer how data items are related and how these relations can be evaluated 

automatically, it becomes possible to process complex filter and search operations.
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1.5 Semantic Annotation in Images    

In general, manual annotation can provide image descriptions at the right level of 

abstraction. It is, however, time consuming and thus expensive. In addition, it proves 

to be highly subjective: different human annotators tend to "see" different things in 

the same image. On the other hand, annotation based on automatic feature extraction 

is relatively fast and cheap, and can be more systematic.

In the process of image annotation, we may find values for attributes or relationships 

that are not previously present in the knowledge base. The process of enhancing the 

existing metadata could be as simple as entering values for attributes; in that case they

could be automated. Moreover this process could be as complex as modifying the 

underlying schema, in that case some user involvement might be required [11].

To annotate the images, RDF data model can be used. It is based upon the idea of 

making statements about Web resources in the form of subject-predicate-object 

expressions, called triples in RDF terminology. This mechanism for describing 

resources is a major component in what is proposed by the W3C's Semantic Web 

activity: an evolutionary stage of the World Wide Web in which automated software 

can store, exchange, and use machine-readable information distributed throughout the 

Web, in turn enabling users to deal with the information with greater efficiency and 

certainty. RDF's simple data model and ability to model disparate, abstract concepts 

has also led to its increasing use in knowledge management applications unrelated to 

Semantic Web activity [13].

To extract text content information by image pattern recognition technology would be 

a cost way to get semantic information of one picture as it requires complicated and 

optimized algorithm to realize it. To solve these challenges, RDF documents can be 

used as one of the alternates for image content storage because:   

RDF supports self-defined tags that allows user to setup new defined semantic 

description tags and make further modification. RDF as a mechanism for resource 

description would contribute to the semantic inference based on the ontology theory. 

Its resource/property/value triples character helps to make inference based on the 

description documents. For example, any image can be described in several aspects 
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like brand, and color etc. Below is given an example of image of car annotated in 

RDF format as shown in figure 1.4.  

                                          

Figure 1.4: Honda White Car                                                                  

<image> 

         <pic: contain> 

              <rdf: Description rdf: about=‟http://www.rdf.com/car”>                                                     

                       <car: brand>Honda</car: brand> 

                        <car: color>White</car: color> 

             </rdf: car>                                                                   

       </pic: contain> 

</image>

Now when user types Honda ‘White’ car, the search engine would make inference 

based on the RDF document and finally show image in figure 1.4, which contain the 

description of car with ‘Honda’ brand and ‘white’ color that user is actually looking 

for.  

1.6 Structure of the Thesis

The rest of the thesis is organized in the following order:

Chapter 2 - Provides a review of all the work done in the area of semantic 

annotation for image searching.

Chapter 3 - Gives the problem statement and methodology used to solve it.
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Chapter 4 - Gives a detailed introduction about RDF, semantic image retrieval 

through RDF and provides an idea of a making some self defined tags 

in RDF files. 

Chapter 5 - Explains the experiments performed and evaluates the results achieved.     

Chapter 6 - Presents the conclusion of this thesis and suggestions for future work.

Thesis concludes with references.
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Chapter 2

Literature Review

In the present day scenario, anyone with a server can publish documents for the rest of 

the world to see, and one can hyperlink any document to any other document. More 

amazingly, it does not matter if the page you are browsing is being served up by 

someone in Delhi (India) from a UNIX server or whether your Web browser is in fact 

running on a Macintosh machine in London (England) — if you can browse the page, 

you can link to it.

Search, integration, and Web mining are the three main uses of the Internet. Web 

browsers, Web servers, and even search engines do not actually distinguish weather 

forecasts being provided by any weather forecast site from a scientific papers

providing information about weather forecast. The search engines, for example, are 

therefore forced to do keyword matching only; as long as a given document contains 

the keyword, it will be included in the candidate set which is presented to the user as 

the search result [5].

The Internet is constructed in such a way that its documents only contain enough

information for the computers to present them, not to understand them. Requirement 

is to reconstruct the Web by adding some information into the documents stored on 

the Internet so that the computers can process this extra information and understand 

what a given document is really about.

The real reason for difficulty is that the current Internet is not constructed well; 

computers can only present users with information, but they cannot “understand” the 

information well enough to display the data as per user’s requirement. Another 

difficulty is integration, there is too much manual work involved and more 

automation is required. There is a need for improvement especially for searching 

activity so that the results are more relevant.

One of the promising solutions to all these problems is Semantic Web. Tim Berners-

Lee [5], who presented the idea of Semantic Web, describes it as “an extension of the 

current Web in which information is given well-defined meaning, better enabling 
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computers and people to work in cooperation”. The concept behind Berners-Lee’s 

idea was to use hypertext as a means of organizing a distributed document system [5].

Presently, the Hypertext Transport Protocol (HTTP) is used to request documents, 

which are received by programs and a Web server uses a URL provided in the request 

to determine which file to deliver. Despite its popularity, HTML suffered from two 

problems. First, whenever someone felt that HTML was insufficient for their needs, 

they would simply add additional tags to their documents, resulting in a number of 

non-standard variants. Second, because HTML was mostly designed for presentation 

to humans, it was difficult for machines to extract content and perform automated 

processing on the documents [24].

To solve these problems, the World Wide Web Consortium (W3C) developed the 

Extensible Markup Language (XML) [24]. XML (Extensible Markup Language) is an 

industry-standard, system-independent way of representing data. XML was designed 

to transport and store data, with focus on what data is whereas, HTML was designed 

to display data, with focus on how data looks. In other words, it can be said that 

HTML is about displaying information; while XML is about carrying information. 

XML too could not provide machine understandable construct as the XML  schema  

provides  a  syntactic  description  of  data  and  it  does  not  provide semantics  to  

the  data and these Schemas use a restricted tag set to describe the structure of an 

XML document and are syntactically constrained to form a balanced tree (i.e., every 

starting tag must have a corresponding closing tag). Although, XML  provides  many  

different  possibilities  to  encode  domain  of  discourse,  but  this  leads  to  

difficulties  when  understanding  of  foreign documents  is  required.

The Resource Description Framework (RDF) is a language designed to support the 

Semantic Web. It is a W3C recommendation that attempts to address XML’s semantic 

limitations. It presents a simple model that can be used to represent any kind of data. 

It consists of nodes connected by labeled arcs, where the nodes represent Web 

resources and the arcs represent properties of these resources. 

RDF supports self-defined tags that allow user to define semantic description tags and 

hence, it serves as a mechanism for resource description, contributing to the semantic 
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inference based on the ontology theory. Its resource/property/value triples character 

helps to make inferences based on the description documents. By using these 

characteristics, RDF has been successfully applied for image search and results of 

image search through RDF are much faster and precise [14].

To enhance the semantic interpretability of images semantic annotation can be added 

for describing the basic characteristics of images in RDF. Semantic annotations can 

be coarsely classified as being formal or informal. Formal semantic annotations 

follow representation mechanisms, drawn on conceptual models, represented using 

well-defined knowledge representation languages [5]. 

Since the starting of this decade lot of research has been focus on semantic annotation 

of image collections. In [15] a tool for semantic annotation and search in a collection 

of art images has been discussed. Multiple existing ontologies are being used to 

support this process, including the Art and Architecture Thesaurus, WordNet, ULAN 

and Icon-class. Knowledge-engineering aspect such as the annotation structure and 

links between the ontologies has been discussed and some ideas have been proposed 

on how a semantic Web for images might work. Semantic annotation allows us to

make use of concept search instead of keyword search. It paves also the way for more 

advanced search strategies. For example, users can specialize or generalize a query 

with the help of the concept hierarchy when too many or too few hits are found.

Oge Marques and Nitish Barman [16] proposed semi-automatic semantic annotation 

of images using machine learning techniques. It was suggested that the success of the 

Semantic Web hinges on ability to produce semantic mark-ups on Web pages and 

their components, in a way that is cost-effective and consistent with adopted schemas 

and ontologies. Since images are an essential component of the Web, their work

focused on an intelligent approach to semantic annotation of images. Three-layer 

architecture was proposed, in which the bottom layer organizes visual information 

extracted from the raw image contents, which was mapped to semantically 

meaningful keywords in the middle layer, which were further connected to schemas 

and ontologies on the top layer. The key contribution was the use of machine learning 

algorithms for user-assisted and semi-automatic image annotation in such a way that 

the knowledge of previously annotated images - both at metadata and visual levels -



22

was used to speed up the annotation of subsequent images within the same domain as 

well as to improve future query and retrieval of annotated images.

According to Osman, T. et al. [17] most image search engines rely on free-text search 

that often returns inaccurate sets of results based on the recurrence of the search 

keywords in the text accompanying the images. They suggested that, to maximize the 

benefit of the colossal repository of digital images available both publicly and in 

private collections, intelligent matchmaking tools are required. In their paper, a 

semantically-enabled image annotation and retrieval engine that relies on 

methodically structured ontologies for image annotation allowing for more intelligent 

reasoning about the image content and subsequently obtaining a more accurate set of 

results and a richer set of alternatives matchmaking the original query .

Elahi, N., Karlsen, R., and Akselsen, S. [18] proposed to  improve  the  quality  of  

image  retrieval  and  image management  with  the  help  of  context  information  

over  the Web. Their hypothesis  was that  leveraging the semantic annotated 

contextual  metadata  of  the  image  would  yield  the  relevant search  results  and  

facilitate  building  a  consistent, unambiguous  image knowledge base. According to 

the authors, inference capability of semantic technology is very useful to deduce the 

new metadata from the existing metadata about images. 

After going through various proposal presented for semantic annotations of images it 

has been realized that precision of image retrieval can be improved, by using textual 

annotation to the images available on WWW. RDF which serves as a basic language 

for realizing the dream of Semantic Web can be used as mean to describe all the 

resources based on some predefined rules. This helps the searching process more 

systematic because the search engine directly approach to RDF documents for 

getting the reliable information related to search and returns more relevant results.

Here we propose a semantic annotation method for image retrieval using RDF and 

accuracy of the search results has been validated with the use of SPARQL query 

engine which takes RDF as input.



23

Chapter 3

Problem Statement

3.1 Problem definition

During the literature survey, it was analyzed that the Semantic Search targets to make 

the process of image search on the Internet more compliant, according to the need of 

the user, by making search operation based on the image annotation and not on the 

keyword matching only. Earlier, the algorithms related to searching, inherently 

approached to keyword matching for searching the textual content but, whenever 

these algorithms were applied for searching non-text content, it resulted into a non-

semantic search. Most of the search results were not correlating themselves to the 

actual need of the user because the algorithms did not possessed any meaning to know 

what context a user is searching for. So, these algorithms kept on the evolving over a 

long period of time by incorporating advance concepts on existing technologies like 

HTML. New concepts like XML, RDF, OWL were introduced which facilitate the 

semantic search on the Web. Finally, keyword searching is being replaced by the 

semantic searching based on the RDF documents of the resources (like images). In 

these RDF documents, resources are annotated by adding all the required pieces of 

information for making the search more intuitive and relevant.

The main objective is to create a resource repository of images related to a concept 

like car, airplane etc. A repository of RDF document will be created to annotate the 

images where the RDF document serves as a data model. Data model developed needs 

to be validated, which can be done using online W3C RDF validation service RDF 

model developed will be queried using SPARQL query engine. 

3.2 Methodology

The step-by-step methodology to be followed in enabling Semantic Search on 

resource repository of images is given below:

 Study of the semantic Web technologies like RDF, OWL etc. 

 Review of all image search engine methods used for text and non-text search.

 Create a RDF documents for important concepts and annotate these documents 

using RDF editor tool. 
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 Validate the RDF document through W3C RDF validation service.

 Run the SPARQL queries on developed RDF documents with the use of 

Twinkle SPARQL Tool.
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Chapter 4

Resource Description Framework (RDF)

Now a day’s, information is the most important resource available.  Information has 

diverse and overlapping groups of producers and consumers, which needs several

media for communication between them.  Internet represents the latest evolution of 

such communication channels.  The success of Internet is greatly attributed to two 

application layer protocols HTTP and HTML. Hyper Text Transfer Protocol (HTTP) 

and  Hyper  Text  Markup  Language  (HTML)  provide  a  reliable,  communication 

channel. HTML is essentially a presentation layer language for formatting web pages.  

Since HTML has no  inherent semantics,  i.e.,  it does not provide a description of  the 

Web  page,  a  major  shift  in  this  paradigm  is  required.  The  World  Wide  Web 

Consortium,  recognizing  this need,  introduced  standardized protocols  such as 

XML, RDF  and  OWL  to  address  the  semantics  issue.  In  the  present  scenario  a  

search application  that can understand  the  semantics of a Web  search will provide a 

better-refined search than conventional text based searches.  

4.1 Resource Description Framework (RDF)

Resource Description Framework was proposed by the World Wide Web Consortium 

to overcome the semantic limitations of XML.  It  is  a  foundation  for processing 

metadata;  it provides  interoperability  between  applications  that  exchange

machine-understandable information on the Web and emphasizes facilities to enable

automated processing of Web resources.  

The Resource Description Framework (RDF) is an extremely flexible technology, 

capable of addressing a wide variety of problems as it is a language designed to 

support the Semantic Web, in much the same way that HTML is the language that 

helped initiate the original Web. RDF is a framework for supporting resource 

description, or metadata (data about data), for the Web and it provides common 

structures that can be used for interoperable XML data exchange. 

As a result of many communities coming together and agreeing on basic principles of 

metadata  representation  and  transport,  RDF  has  drawn  influence  from  several 
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different  sources.  The  main  influences  have  come  from  the  Web  standardization 

community itself in the form of HTML metadata and PICS, the library community, 

the structured document  community  in  the  form of SGML and more  importantly 

XML, and also the knowledge representation (KR) community. There are also other 

areas of technology  that  contributed  to  the  its  design;  these  include  object-

oriented programming and modeling  languages, as well as databases. Although RDF 

draws from the KR community, it does not specify a mechanism for reasoning [19].

4.1.1 RDF Triples

 A simple model for “statements”

 Subject: what the statement is about

 Predicate: a property of the subject

 Object: the value of the property

 A natural way to describe the vast majority of the data processed by machines.

In figure 4.1, the subject is http://doc, predicate is dc:creater and the object is 

Joe Smith.

    

Figure 4.1: A simple RDF assertion

RDF is a general method to decompose information into pieces. The emphasis is on 

general here because the same method can be used for any type of information. In 

RDF information is expressed as a list of statements in the form SUBJECT,

PREDICATE, OBJECT. The subject and object are names for two things in the 

world, and the predicate is the name of a relation between the two. In short, predicates 

can be considered as verbs.

Consider an example where information about an apartment is break down into RDF 

statements:

SUBJECT              PREDICATE                 OBJECT

      I                            own                            my apartment
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my apartment              has                            my computer

my apartment              has                            my bed

my apartment              is in                           hiladelphia

These four lines express four facts. Each line is called a statement or triple. The 

subjects, predicates, and objects in RDF are always simple names for things: concrete 

things, like an apartment, or abstract concepts, like has. These names don't have 

internal structure or significance of their own. They're like proper names or variables. 

4.1.2 RDF Specifications

 The RDF specification was originally released as one document, the RDF 

Model and Syntax, or RDF. However realizing some problems in the initial 

release, updated specification released  six new documents: RDF Concepts and 

Abstract Syntax, RDF Semantics, RDF/XML Syntax Specification, RDF 

Vocabulary Description Language 1.0: RDF Schema, the RDF Primer, and the 

RDF Test Cases. 

 The RDF Concepts and Abstract Syntax and the RDF Semantics documents 

provide the fundamental framework behind RDF: the underlying assumptions 

and structures that makes RDF unique from other metadata models (such as the 

relational data model). These documents provide both validity and consistency 

to RDF - a way of verifying that data structured in a certain way will always be 

compatible with other data using the same structures. The RDF model exists 

independent of any representation of RDF, including RDF/XML [20]. 

The broad goal of RDF  is to define a mechanism for describing resources that makes 

no  assumptions  about  a  particular  application  domain,  nor  defines  (a  priori)  the 

semantics of any application domain [21]..  

4.1.3 Basic RDF Model

RDF  is model  and XML  syntax  for  representing  information  in  a way  that  

allows programs  to  understand  the  intended  meaning.  It represents information 

about resources on the Web, i.e., metadata about resources. A resource in RDF is 

mapped to a Uniform Resource Identifier (URI) and is described in terms of its 
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properties. The purpose  is  to  make  statements  about  resources,  which  can  be  

viewed  as labeled edge (property) between two nodes (object and property value).

The  foundation  of RDF  is  a model  for  representing  named  properties  and  

property values. Its properties may be thought of as attributes of resources hence

correspond to traditional attribute-value pairs. Its properties represent relationships 

between resources and an RDF model can therefore resemble an entity-relationship 

diagram.  In object-oriented design terminology, resources correspond to objects and 

properties correspond to instance variables [22].  

The RDF data model is a syntax-neutral way of representing RDF expressions. Two 

RDF expressions are equivalent if and only if their data model representations are the 

same. The basic data model consists of three object types:

 Resource

All things being described by RDF expressions are called resources. A resource may

be an entire Web page; such as the HTML document 

"http://www.w3.org/Overview.html" for example. A resource may be a part of a Web 

page; e.g. a specific HTML or XML element within the document source. A resource 

may also be a whole collection of pages; e.g. an entire Web site. 

 Property

A property is a specific aspect, characteristic, attribute, or relation used to describe a 

resource. Each property has a specific meaning, defines its permitted values, the types 

of resources it can describe, and its relationship with other properties. This object type 

does not address how the characteristics of properties are expressed.

 Statement

A specific resource together with a named property plus the value of that property for 

that resource is an RDF statement. As mentioned earlier, these three individual parts 

of a statement are called, the subject, the predicate, and the object respectively.

Example:
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In RDF resources are identified by a resource identifier. A resource identifier is a URI 

plus an optional anchor id. Consider as a simple example the sentence: Ora Lassila is 

the creator of the resource http://www.w3.org/Home/Lassila.  

          {Creator, http://www.w3.org/Home/Lassila, Ora Lassila}

This sentence has the following parts:

                                  

Table 4.1: RDF Format [19]

Figure 4.2 shows the diagram of this RDF statement using directed labeled graphs 

(also called "nodes and arcs diagrams"). In this diagram, the nodes (drawn as ovals) 

represent resources and arcs represent named properties. Nodes that represent string 

literals are drawn as rectangles.

Figure 4.2: Simple node and arc diagram [19]

Thus, such a sentence would be: The individual whose name is Ora Lassila, email 

<lassila@w3.org> is the creator of http://www.w3.org/Home/Lassila.  

The intention of this sentence is to make the value of the Creator property a structured 

entity.  In RDF such an entity is represented as another resource. The sentence above

does not give a name to that resource; it is anonymous, so in the diagram below we 

represent it with an empty oval:

Figure 4.3: Property with structured value [19]

Subject (Resource)  http://www.w3.org/Home/Lassila  

Predicate (Property) Creator

Object (literal)  "Ora Lassila"

http://www.w3.org/Home/Lassila  Ora Lassila

http://www.w3.org/Home/Lassila

Ora Lassila lassila@w3.org

Creator

Name E-mail
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RDF general format:

<?xml version="1.0"?> 

<Class rdf:ID="Resource" 

xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"      

  xmlns="uri"> 

    <property>value</property> 

   <property>value</property> 

    ... 

</Class>

Element description:

rdf:ID                RDF provides an ID attribute for 

identifying the resources being    

described.      The value of rdf:ID is a 

"relative URI".  The  "complete  URI"  is  

obtained  by concatenating  the URL of  

the XML document with "#" and then the 

value of rdf:ID.

resource  Identifies the resource being described.

xmlns:rdf  The ID attribute is in the RDF 

namespace.

Class     Identifies the type (class) of the resource 

being described.

property  These are properties, or attributes, of the 

type (class).

value    Values of the properties.
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Some other elements rdf:about                   Instead  of  identifying  a  resource  with  

a  relative  URI (which  then  requires  a  

base URI  to be  attached before relative 

URI  ), we  can  give  the  complete  

identity  of  a resource.    However,  we  

use  rdf:about,  rather  than rdf:ID.

Table 4.2: RDF elements description [19]

4.1.4 Advantages of using RDF:

1. The RDF format, if widely used, will help to make XML more interoperable:

 Tools  can  instantly characterize  the  structure,  "this  element  is  a  type  

(class), and here are its properties”. 

 RDF promotes the use of standardized vocabularies, standardized types 

(classes) and standardized properties.

2. The RDF format gives a structured approach to design XML documents. The 

RDF   format is a regular, recurring pattern.

3. It enables quick identification of weaknesses and inconsistencies of non-RDF-

compliant XML designs, providing better understanding of the data.

4. RDFS gives the benefits of both worlds:

 Standard XML editors and validators to create, edit, and validate XML file. 

 Use the RDF tools to apply inferencing to the data.

5. It positions the data for the Semantic Web.

4.2 Annotating Images Using RDF

Images are not structured documents like text information; at the same time, the 

current mechanism is too rigid to make some modification and always ineffectively 

use information provided by users except keywords. Before the emergence of the 

RDF, the keywords for the image search were based on the filename of the image, the 

link text pointing to the image, and text adjacent to the image. To enhance and 

optimize search results, RDF standard is used now to describe the image resource 

with attributes as its weight for such content descriptive phrase, which would help 

user in providing new content description to images by adding new self-defined tags 

into resource description. 
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Consider images of cars with all the possible specifications i.e. brand, model, color, 

wheelbase, kerbweight etc. If user’s query is for car of brand ‘Honda’ or ‘Maruti, all 

the images of car will be displayed, irrespective of the brand mentioned by the user. 

A simple RDF for figure 4.4 (a)

<?xml version="1.0"?>

<rdf:RDF  xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"       

xmlns:car="http://www.flickr.com/search/?q=honda+city+car#">

<rdf:Description 

rdf:about="http://www.flickr.com/photos/marcusvieira/3839909947/">

<car:brand>Honda</car:brand>

</rdf:Description>

</rdf:RDF>

When the user searches Honda City car with ‘red’ color and/or wheelbase=2300 

and/or kerbweight=1350, the search engine will not be able to provide the desired 

result as there is no annotation for these attributes in the above RDF; instead, the 

information returned is of all ‘Honda’ cars regardless of its ‘color’, ‘wheelbase’ and 

‘kerbweight’.

To make the image retrieval more accurate and precise and to make machine more 

understandable RDF document are augmented with self defined tags. The image 

annotation process will be improved by using such tags. In RDF document, we can 

give as much as possible information about any image. 

Examples: 

                         

(a) Honda City ‘red’ Car                                       (b) Maruti Suzuki SX4 White Car             

Figure 4.4: Cars Images with different brand, model and color
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Resource description framework for Figure 4.4 (a) with semantic annotations

<?xml version="1.0"?>

<rdf:RDF  xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"       

xmlns:car="http://www.flickr.com/search/?q=honda+city+car#">

<rdf:Description 

rdf:about="http://www.flickr.com/photos/marcusvieira/3839909947/">

<car:brand>Honda</car:brand>

<car:model>Honda City</car:model>

<car:color>red</car:color>

<car:wheelbase>2300</car:wheelbase>

<car:kerbweight>1350</car:kerbweight>

<car:weight>10</car:weight>

</rdf:Description>

</rdf:RDF>

Resource description framework for Figure 4.4 (b) with semantic annotations

<?xml version="1.0"?>

<rdf:RDF  xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"       

xmlns:car="http://www.flickr.com/search/?q=maruti suzuki+sx4+car#">

<rdf:Description rdf:about=" http://www.flickr.com/photos/labeeb-

xaman/2528477801/">

<car:brand>Maruti Suzuki</car:brand>

<car:model>SX4</car:model>

<car:color>white</car:color>

<car:wheelbase>2250</car:wheelbase>

<car:kerbweight>1100</car:kerbweight>

<car:weight>9</car:weight>

</rdf:Description>

</rdf:RDF>

When user searches Honda City ‘red’ car or car with wheelbase=2300 or kerbweight= 

1350, the search engine will make inference based on the corresponding RDF 

document and finally provide the set of images (given in figure 4.4 (a)) fulfilling the 

user demand. Similarly, when the user searches Maruti Suzuki SX4 white car with 
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wheelbase=2250 and kerbweight=1100, the search engine will make inference based 

on the respective RDF document and finally provide the desired image (given in 

figure 4.4 (b)).  

Hence, by creating the RDF document for any image or resource and providing 

maximum content description to that image or resource, we have enhanced the 

searching process and the images retrieved are more semantic in comparison to 

traditional search.

Second enhancement proposed in this thesis for semantic retrieval is to add weight 

tag in RDF document. As the number of users of any image increases, the weight 

corresponding to the searched keyword will increase and therefore increasing the 

ranking of that image with respect to that searched keyword.

By injecting the Web 2.0 features we can obtain more semantic image content 

description in the following ways:

Figure: 4.5: Indian cricket player Sachin Tendulkar

Consider the XML for figure 4.5

(i) <?xml version="1.0"?>

<sample>                                                                            

    <keyword att = "Sachin Tendulkar">1</keyword>

    <link>http://www.flickr.com/photos/Sachin Tendulkar/ 

</sample> 

In figure 4.5 - Initial description of an image regarding a famous Indian cricket player 

Sachin Tendulkar. “att” provides the keyword description for the image while the 

value ‘1’ describes the initial weight for the keyword of “Sachin Tendulkar”.
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The users searches images using such keywords and get various images as the result. 

Further, when the user just selects one of these images, it means the content 

description is confirmed by user’s selection. The value of <weight> tag, which 

performs a very important role in the ranking of the result, will be increased by 1 for 

the keyword “Sachin Tendulkar” in RDF document of the image shown in figure 4.5.

The third idea [23] proposed for increasing the semantic image search is to add 

category tag which can further increase the accuracy and precision of search. 

While performing search operation, the user’s background information is added in the 

related RDF document as additional semantic information for keywords to overcome 

from the situation where that keyword has several various meaning in different 

contexts.

To present more precise result to the users with different occupations, hobbies, and 

some other background profiles, we need to modify ranking algorithm for

accommodating the factor of user interaction in order to present individual ranked 

result for various individuals even they use the same keyword to perform search 

operation. New evaluation method is:

For each image, except content description, add category description:

                   

         

Figure 4.6 Image search result for eclipse keyword

RDF for adding category tag
<category> 
<class attribute=’ ’>weight</class> 
… 
  <class attribute=’ ’>weight</class> 
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</category>

<class> tag’s attribute corresponds to users’ background info description terms like 

occupation: ‘software engineer’, hobby: ‘cars’, ‘astronomy’, etc.   

Figure 4.6 shows the example of using user background information for describing

the category of images. As some people searching for images of cars would probably 

choose the first image. As soon as, the car fans choose the first image as the result for 

the search after keyword of ‘eclipse’, this image would add value car to the attribute 

‘attribute’ of <class> tag to the category description section and with other car fans’ 

confirmations, the value of weight for <class> tag will be increased for that particular 

value of ‘attribute’ attribute. The similar procedure will be followed in case of 

software and astronomy.

Rank Grade =   Class Weight + keyword Weight

The Rank Grade will decide the search result of images. If one image has highest 

Rank Grade, it will come on the top level of the result and other images with the 

lowest Rank Grade will come in the last page. The Rank Grade totally depends upon 

appropriate semantic annotation of images and semantically searches of those images.

4.3 Tools and Browsers

The following tools have been used in solving the problem stated in problem 

statement section.

4.3.1 RDF Editor

RDF Editor is used to write and edit RDF documents. It generates and saves N-Triple 

reports on any platform. 

RDF Editor Interface:

Available Menus

File Menu

File -> New             -          Creates a New RDF File.

File -> Open             -          Opens a current existing RDF File.
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File -> Save              -          Saves the currently open RDF File.

File -> Save Report - Saves the report that you have generated. (Report area is            

the text area in the bottom half. Whatever you see there will be saved).

File -> Exit   - Exit the application.

Edit Menu

Edit -> Copy All - Copy the whole RDF document that is currently open and put it in 

clipboard.

Edit -> Undo       -   1-level down implementation of undo. If someone accidentally 

add or remove any component from the file, you can use undo to undo the previous 

action. Pressing undo twice will bring back the change done.

Tools Menu

Tools -> Generate N-Triple report - Generate N-Triple report from the currently open 

RDF file and show it in the Report area (bottom half).

4.3.2 Twinkle: Sparql Tools

Twinkle is a simple GUI interface that wraps the ARQ SPARQL query engine. The 

tool should be useful both for people wanting to learn the SPARQL query language, 

as well as those doing Semantic Web development. 

Features:

 Load, edit and save SPARQL queries.

 Insert PREFIX statements into queries.

 Configure custom namespaces so they can be quickly inserted into queries.

 Cancel long running queries.

 Save results to file.

 Query local files and remote RDF documents.

 Query RDF data held in relational databases.

 Query online SPARQL endpoints, such as DBpedia, reyvu.com and 

GovTrack.

 Query using standard SPARQL, or the ARQ extended syntax which supports 

COUNT, etc.
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 Use ARQ extension functions and property functions.

 Apply inferencing (e.g. Jena rules, RDF Schema, OWL ontology) when 

running queries.

 Configure commonly used data sources for quick access.
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Chapter 5

Implementation and Results

5.1 RDF document creation

RDF Editor is used to make the RDF document for cars image repository. Self 

defined tags are used to annotate the images. Figure 5.1 shows RDF document created 

using RDF Editor.

Figure 5.1: Creating RDF document using RDF Editor
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The RDF document has been validated through online W3C RDF validation Service. 

This validation process generates the triples (subject, predicate, and object) for the

RDF document (Data Model). The validation process is shown in figure 5.2:

Figure 5.2: Validation of RDF using W3C RDF Validation Service



Figure 5.3 shows the graph

predicate and object (triples)

Figure 5.3

the graph generated for our data model show

ject (triples) of few entities of RDF document.

Figure 5.3: Graph of Two Entities of RDF Document

41

data model showing the subject, 

of RDF Document
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5.2 Query Results

SPARQL tool is used to query the RDF document from different perspectives. The 

SPARQL, a RDF Query Language, has been used to write queries.

5.2.1 Query 1

Query 1 (as shown in figure 5.4) retrieves all the information for concept cars from 

the RDF document generated in figure 5.1. Results are generated in the form of triples

(path, attribute, value). 

Figure 5.4: Query and output for all type of cars
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5.2.2 Query 2

Figure 5.5 shows output for query on “all cars of Maruti Suzuki brand” irrespective of 

any model and any color.  

Figure 5.5: Query and output for cars of Maruti Suzuki brand
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5.2.3 Query 3

Figure 5.6 shows output for query on “cars with model name ‘Honda’, color ‘red’ and

kerbweight = 1250 kg.

Figure 5.6: Query and output for cars of ‘Honda’ brand, color is ‘red’ and 

kerbweight=1250 kg.
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5.2.4 Query 4

Figure 5.7 retrieves the information regarding cars which have ‘red’ color whether 

they are ‘Honda’ cars or Maruti cars.

Figure 5.7: Query and output for all cars those have ‘red’ color
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5.2.5 Query 5

As shown in figure 5.8, query targets to retrieve the information of cars of any model, 

any color and any kerbweight for ‘Honda’ brand. 

Figure 5.8: Query and output for all cars those have ‘Honda’ brand
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5.2.6 Query 6

Figure 5.9 shows query and output for information of cars which have kerbweight <

1275 kg.

Figure 5.9: Query and output for all cars those have kerbweight < 1275 kg.
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Chapter 6
Conclusion and Future Scope

6.1 Conclusion

This thesis work concludes that the RDF is a very powerful tool to annotate images 

and create data models for the repositories of the different types of resources. The 

predefined tags used in RDF capture all the targeted information about the resources 

(images in our case) and put ahead a way to make all the searches over the defined 

repository more relevant and accurate.

The SPARQL, a query language as well as a data access protocol, armed with all 

features that any general purpose query language can possess solves the purpose of

making RDF a true machine understandable language. It has been confirmed that the 

query results exactly match with what the user desires.

Both, the RDF and the SPARQL combined together can serve as a platform to fulfill 

the vision of Semantic Web, as proposed by Tin Berners Lee. As the amount of 

images are growing exponentially on the WWW, using self defined tags and 

annotations will always increase the efficiency and precision of image retrieval.

6.2 Future Scope of Work

There is scope for extending this thesis work on the following aspects:

 The RDF document of car repository can be modified by adding new tags to it 

which can bring additional information to data model of cars and therefore 

enhancing the users’ capability to search more meaningful contents or making 

a way to enhanced semantic search over the Internet.

 More profound SPARQL queries can be written in order to provide other 

related contents (those contents which are semantically linked to the exact 

content) to the users in response to their search on the Internet.
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Appendix-A

The original RDF/XML document developed for various models of 

cars. 

<?xml version="1.0"?>
<rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#" 
xmlns:car="http://www.flickr.com/car#">

<rdf:Description rdf:about="http://www.flickr.com/car/Honda-Gxi.jpg">
<car:brand>Honda</car:brand>
<car:model>Honda City</car:model>
<car:color>red</car:color>
<car:wheelbase>2250</car:wheelbase>
<car:kerbweight>1250</car:kerbweight>
<car:weight>9</car:weight>

</rdf:Description>

<rdf:Description rdf:about="http://www.flickr.com/car/Honda-Dxi.jpg">
<car:brand>Honda</car:brand>

               <car:model>Honda City</car:model>
               <car:color>red</car:color>
               <car:wheelbase>2300</car:wheelbase>
               <car:kerbweight>1350</car:kerbweight>
               <car:weight>10</car:weight>
</rdf:Description>

<rdf:Description rdf:about="http://www.flickr.com/car/Honda-Gxi1.jpg">
<car:brand>Honda</car:brand>

               <car:model>Honda Accord</car:model>
               <car:color>white</car:color>
               <car:wheelbase>2400</car:wheelbase>
               <car:kerbweight>1275</car:kerbweight>

<car:weight>7</car:weight>
</rdf:Description>

<rdf:Description rdf:about="http://www.flickr.com/car/1404285524.jpg">
<car:brand>Honda</car:brand>

               <car:model>Honda Accord</car:model>
               <car:color>red</car:color>
               <car:wheelbase>2500</car:wheelbase>
               <car:kerbweight>1400</car:kerbweight>
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<car:weight>8</car:weight>
</rdf:Description>

<rdf:Description rdf:about="http://www.flickr.com/car/maruti-suzuki-sx4-extf.jpg">
<car:brand>Maruti Suzuki</car:brand>

                <car:model>SX4</car:model>
                <car:color>White</car:color>
                <car:wheelbase>2550</car:wheelbase>
                <car:kerbweight>1100</car:kerbweight>

<car:weight>10</car:weight>
</rdf:Description>

<rdf:Description rdf:about="http://www.flickr.com/car/maruti-suzuki-sx4-extf1.jpg">
<car:brand>Maruti Suzuki</car:brand>

                <car:model>SX4</car:model>
                <car:color>red</car:color>
                <car:wheelbase>2400</car:wheelbase>
                <car:kerbweight>1150</car:kerbweight>

<car:weight>9</car:weight>
</rdf:Description>

<rdf:Description  rdf:about="http://www.flickr.com/car/maruti-suzuki-swift-
dzire.jpg">

<car:brand>Maruti Suzuki</car:brand>
                <car:model>Swift</car:model>
                <car:color>white</car:color>
                <car:wheelbase>2300</car:wheelbase>
                <car:kerbweight>1050</car:kerbweight>

<car:weight>10</car:weight>
</rdf:Description>

<rdf:Description rdf:about="http://www.flickr.com/car/maruti-suzuki-swift-
dzire1.jpg">

<car:brand>Maruti Suzuki</car:brand>
                <car:model>Swift</car:model>
                <car:color>red</car:color>
                <car:wheelbase>2350</car:wheelbase>
                <car:kerbweight>1200</car:kerbweight>

<car:weight>11</car:weight>
</rdf:Description>
</rdf:RDF>


